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VERIZON WIRELESS 
USER MANUAL 
 
WELCOME 
Using our wireless function, you can connect to the Internet, corporate intranet, and your email 
while you're away from the office at high speed. This manual will provide information needed to 
get started and effectively use your system and VZAccess Manager software. 
WIRELESS COMMUNICATIONS 
Important Notice 
Due to the transmission and reception properties of wireless communications, data can 
ccasionally be lost or delayed. 
This can be due to the variation in radio signal strength that results from changes in the 
characteristics of the radio transmission path. Although data loss is rare, the environment where 
you operate the modem may adversely affect communications. 
Variations in radio signal strength are referred to as fading. Fading is caused by several different 
factors including signal reflection, the ionosphere, and interference from other radio channels. 
Verizon Wireless or its partners will not be held responsible for damages of any kind resulting 
from the delays or errors in data transmitted or received with the WWAN device, or failure of the 
WWAN device to transmit or receive such data. 
SAFETY HAZARDS 
Do not operate the WWAN device in an environment that may be susceptible to radio 
interference resulting in danger specifically; 
�� Areas where prohibited by the law  
o Follow any special rules and regulations and obey all signs and notices. Always turn off the host 
device and remove the modem from the card slot when instructed to do so, or when you suspect 
that it may cause interference or danger. 
�� Where explosive atmospheres may be present 
o Do not operate your modem in any area where a potentially explosive atmosphere may exist. 
Sparks in such areas could cause an explosion or fire resulting in bodily injury or even death. Be 
aware and comply with all signs and instructions. 
o Users are advised not to operate the modem while at a refueling point or service station. Users 
are reminded to observe restrictions on the use of radio equipment in fuel depots (fuel storage 
and distribution areas), chemical plants or where blasting operations are in progress. 
o Areas with a potentially explosive atmosphere are often but not always clearly marked. 
Potential locations can include gas stations, below deck on boats, chemical transfer or storage 
facilities, vehicles using liquefied petroleum gas (such as propane or butane), areas where the air 
contains chemicals or particles, such as grain, dust or metal powders, and any other area where 
you would normally be advised to turn off your vehicle engine. 
�� Near Medical and life support equipment 
o Do not operate your modem in any area where medical equipment, life support equipment, or 
near any equipment that may be susceptible to any form of radio interference. In such areas, the 
host communications device must be turned off. The modem may transmit signals that could 
interfere with this equipment.  
�� On an aircraft, either on the ground or airborne 
 
o In addition to FAA requirements, many airline regulations state that you must suspend wireless 
operations before boarding an airplane. Please ensure that the host device is turned off and your 
modem is removed from the card slot prior to boarding aircraft in order to comply with these 
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regulations. The modem can transmit signals that could interfere with various onboard systems 
and controls. 
�� While operating a vehicle 
o The driver or operator of any vehicle should not operate a wireless data device while in control 
of a vehicle. Doing so will detract from the driver or operator's control and operation of that 
vehicle. In some countries, operating such communications devices while in control of a vehicle is 
an offence. 
 

1 GETTING STARTED 
This section will walk you through how to get started using the WWAN device. This includes 
software and driver installation, inserting the card so Microsoft Windows is able to detect and 
install the drivers for the WWAN device and setting up a data session to connect to the Internet. 
 
1.1 YOUR VERIZON BROADBAND ACCOUNT 
For information about your Verizon Broadband account, User Name, Password; please contact 
Verizon Wireless at 1-800- 256-4646. For Technical Support please contact Verizon Wireless at 1-
866-788-9387. 
 
The WWAN device utilizes the Verizon Broadband Network to connect to the Internet transferring 
data at rates of 300-600 kbps, and bursts speeds of up to 2.4Mbps. The VZAccess Manager 
software will allow you to control and monitor your connection to the Verizon Broadband 
network. It will also allow you to send and receive SMS (Short Messaging Service), get online 
help and has an address book. 
 
1.2 GETTING STARTED 
VZAccessSM Manager from Verizon Wireless: 
Welcome to the Verizon Wireless VZAccess Manager. The VZAccess Manager provides a one-
touch connection to the wireless Internet. It has built-in support for WWAN and Wi-Fi devices to 
give you the flexibility you need while you are mobile to connect your laptop to the Internet 
wirelessly. 
 
1.3 SUPPORTED SERVICES 
VZAccess Manager supports the following services from Verizon Wireless: 
1. Quick 2 NetSM (14.4 kbps) - This connection operates at 14.4 kbps and provides a connection 
to the Internet. Additional per-minute changes apply. 
2. Dial-Up-Data Service - This allows you to use your wireless device to dial into your corporate 
network, or other services you normally dial into, over a regular phone line. This connection 
operates at 14.4 kbps. Additional per-minute changes apply. 
3. NationalAccess - NationalAccess delivers typical speeds of 60 to 80 kbps, bursting up to 144 
kbps*. This service requires subscription to a NationalAccess plan. Additional information is 
available at www.verizonwireless.com/b2c/mobileoptions/nationalaccess/index.jsp. 
4. BroadbandAccess - This requires a BrandbandAccess capable PC and provides a wireless 
broadband connection to the Internet. Verizon Wireless BroadbandAccess is one of the fastest, 
fully mobile wireless Internet data solutions available. Quickly download complex files and view 
email attachments at broadband-like speeds (typical speeds of 300-500 kbps, capable of 
reaching speeds up to 2 Mbps). Today this subscription service is 
available in the Washington, D.C. and San Diego areas. Visit 
www.verizonwireless.com/b2c/mobileoptions/broadband/index.jsp for service availability and 
additional details. Note: Present BroadbandAccess Equipment devices also support 
NationalAccess, but do not support Quick 2 Net or Dial- Up-Data Service.  
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Note: You do not need a separate Internet service provider (ISP) to access the Internet when 
using Quick 2 Net, NationalAccess, or BroadbandAccess. * Speed claim based on our network 
tests with 101 Kilobyte FTP data files. Actual throughput speed and coverage vary. 

 
2 INSTALLATION AND CONFIGURATION 
This section will guide you through the installation and setup process for the VZAccess Manager. 
Before getting started, you should become familiar with the documentation that came with your 
mobile phone or PC Card. 
Getting Started 
Follow these steps to install VZAccess Manager: 
1. Turn on your computer and close all applications. 
2. Insert the CD-ROM into your CD drive. 
3. If set up does not automatically start, click the Start button on the taskbar and choose Run. 
Type D:\Start (where D is the letter of your CD-ROM drive) and click OK. 
4. Follow the steps in the next section... 
Important: VZAccess Manager software must be installed before you insert the PC Card in to the 
computer for the first time. Only after the software has been installed can Windows successfully 
install and configure the PC Card. 
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2.1 THE VZACCESS MANAGER SETUP PROGRAM 
Step 1 

 
Double-click the VZAccess Manager setup program. 
You will be presented with a "Welcome" screen. Click the Next button to continue with the 
installation process. 
Step 2 

 
After the Welcome screen you will see the VZAccess Manager License Agreement. In order to 
install and use this product you must agree with the terms of this agreement. Select "I agree 
with this software license agreement", then click the Next button to continue. If 
you do not agree with this agreement, click the Cancel button to exit. 
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Step 3 

 
You are now ready to select the location on your computer where the VZAccess Manager should 
be installed. It is recommended that you do not modify the default destination folder. Click the 
Next button to continue. 
  

Step 4 

 
You are now ready to begin installing VZAccess Manager components onto your computer. Click 
Next to continue. 

 

 



 6

Step 5 

 
During this step the components of the VZAccess Manager product are being installed onto your 
computer. Installation will occur to the destination folder specified in Step 3 above. 
  

Step 6 

 
Installation is now complete. Click the Finish button to leave the VZAccess Manager setup 
program and begin using your new software The setup program will automatically create a 
VZAccess Manager shortcut on your desktop. 
2.2 THE VZACCESS MANAGER SETUP WIZARD 
After you have successfully completed the installation process of VZAccess Manager, you are 
ready to start the VZAccess 
Manager program and begin your initial setup. The steps in the Setup Wizard are critical to the 
proper operation of VZAccess Manager when using your WWAN or Wi-Fi device to connect to the 
Internet wirelessly. 
Step 1 
Click the Start button, select the Programs menu and choose the VZAccess Manager menu item 
to start the VZAccess Manager program. 
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Step 2 

 
On first-run of VZAccess Manager the Setup Wizard will automatically run. You will be presented 
with a Welcome screen. If you have an Internet connection, it is recommend 
that you check to see if you are running the latest version of VZAccess Manager. Click the Check 
for Updates button to perform this check. Click Next to continue. 
 

Step 3 

 
In this step of the Setup Wizard you must specify the type of wireless device that you intend to 
use with VZAccess Manager. Select "Detect both Wi-Fi and WWAN", "Detect WWAN device only 
(1xEVDO/ 1xRTT/CDMA)". For the purposes of this guide, "Detect both Wi-Fi and WWAN" will be 
used. Please note that your experience in Step 4 may be different if you use a different selection. 
After making the appropriate selection, click Next to continue. 
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Step 4 

 
In this step VZAccess Manager will detect the Wi-Fi adapters on your computer. If your computer 
has a built-in Wi-Fi adapter, you do not need to do anything and can proceed to the next step. 
Otherwise, please insert your Wi-Fi PC Card now. You will need the drivers for the card if not 
already installed on the computer. Once complete, click Next to continue. Note: WWAN (Wireless 
Wide Area Network) denotes any 1xEVDO, 1xRTT or CDMA connection to the Verizon Wireless 
network such as BroadbandAccess, NationalAccess or Quick 2 Net. 
 

Step 5 

 
The VZAccess Manager will now detect and setup your WWAN device. 
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Step 6 

 
In this step you need to select the type of connectivity you wish to use with your wireless device. 
For the purposes of this guide, we will select "USB port".  
Please note that this selection may not be appropriate for your type of wireless device. Once you 
have selected your connectivity option, click Next to continue.  
 

Step 7 

 
In this step the VZAccess Manager will find your wireless device. If you selected USB and have 
not already installed the data cable drivers supplied with the cable, you must install them now. 
To install the data cable drivers click the Cancel button below to exit the Setup Wizard and 
then refer to the documentation included with the cable. Please plug the data cable into your 
wireless phone and then plug the cable into your computer. If your wireless phone is not turned 
on, do so now.  
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For PC Card users, insert your PC Card now, and wait for Windows to detect and install drivers 
for the device. 

 
Once your wireless phone is turned on and connected to your computer, click Next to continue. 
At this point in the setup process VZAccess Manager will attempt to find your wireless device. If a 
device is found, you will see the following screen. 
Step 8 
 
The detection and configuration process for your wireless device is now complete. In this step 
you can elect to run the VZAccess Manager automatically every time you start up your computer. 
To do so, check the "Run VZAccess Manager at Startup" checkbox. Click Finish when complete 
After clicking the Finish button VZAccess Manager will launch the Venturi client install program. 
Follow the on-screen instructions to install the Venturi client. 
Please familiarize yourself with the information in the "Using VZAccess Manager" and "Connecting 
to the Internet" sections of this guide. 
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3 USING VZACCESS MANAGER 
Today's online world offers more services everyday and Verizon Wireless gives you the tools you 
need to take advantage of the best in connectivity solutions. With VZAccess Manager, enjoy the 
freedom and convenience of wireless Internet connectivity from your notebook computer! 
3.1 FEATURES 
WWAN (Wireless Wide Area Network, 1xEV-DO/1xRTT/CDMA) Specific 
Features: 
• Creates a Quick 2 Net (14.4 kbps) connection if supported by your device. 
• Creates a NationalAccess connection if using a NationalAccess capable wireless phone and 
cable, which does not support BroadbandAccess. 
• Creates a NationalAccess - BroadbandAccess connection if using a BroadbandAccess capable 
device. This connection will automatically fall back and attempt connecting via NationalAccess if 
the BroadbandAccess service is unavailable. 
• Copy utility to create wireless copies of your dial-up connections, if supported by your device. 
• Controls the Venturi compression software when using your NationalAccess - BroadbandAccess, 
NationalAccess, or Quick 2 Net (14.4 kbps) connections. 
• Signal strength and battery level display for most wireless phones. 
• Test function for WWAN device. 
 
Other Features: 
• Can also be used to launch all of your dial-up networking connections, if desired. 
• Can launch your browser, e-mail client, VPN or a program of your choice upon connection. 
• Logs connections used, duration and bytes sent and received. 
• See the section "Additional Features" for more information about the features of VZAccess 
Manager.  
• TXT messaging 
 
3.2 GETTING STARTED 
Double click on the VZAccess Manager icon on your desktop or click on the Windows Start menu 
and select VZAccess Manager from the list of Programs. 
About the Connect View 
The VZAccess Manager will open to the Connect view by default. This view is where you manage 
your wireless connections. The Connect view displays all currently available network connections. 
At a glance you can see the signal strength and battery level (if applicable) of your WWAN or Wi-
Fi network. Select "Refresh Networks" or "Refresh Signal Levels" from the "Options" menu to 
update the information in this panel. Your current connection state and the elapsed time of the 
connection are displayed along the bottom of the status bar. 
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If your expected connection does not appear or if you connected your wireless phone and cable, 
or inserted your wireless CDMA PC Card or Wi-Fi Card after starting VZAccess Manager, select 
"Refresh Networks" from the "Options" menu. This 
will cause VZAccess Manager to look for your wireless device(s) and verify network availability. If 
you have any Wi-Fi networks you manually added because they do not broadcast their SSID, 
they will always be displayed, and you will have to refer to the signal strength displayed to know 
when you are in range. See the section "Wi-Fi Specific Settings" for additional details. 
Note that with certain Wi-Fi adapters the signal strength for Wi-Fi networks is not accurate until 
you connect to the network. 
Note: The Quick 2 Net (14.4 kbps) connection is only created when the WWAN option is selected 
during setup and if your wireless device supports it. The NationalAccess connection is only 
created when the WWAN option is selected during setup and if you are using a NationalAccess 
capable device that does not support the Verizon Wireless BroadbandAccess service. If you are 
using a BroadbandAccess capable device a NationalAccess - BroadbandAccess connection will be 
created. This connection will use BroadbandAccess if available and will automatically attempt a 
NationalAccess connection when BroadbandAccess is not available. If you change phones or PC 
Cards, you will need to run the Setup Wizard again. To do this make sure that your phone and 
cable are connected, then select "Run Wizard" from the "Options" menu. 
  

3.3 CONNECTING 
Once your Wi-Fi or WWAN device is properly configured, connecting to the Internet is as simple 
as selecting the network connection type shown in the list and clicking the Connect button. Note 
that the Connect button immediately above the list will change to "Connect WWAN" or "Connect 
Wi-Fi" as appropriate based on the current selection in the networks list. 
1. Select one of the following connections: "NationalAccess", "NationalAccess - 
BroadbandAccess", or "Quick 
2 Net (14.4kbps)". 
2. Click the "Connect WWAN" button when it becomes enabled. 
Once connected, the "Connect WWAN" button will change to "Disconnect". Simply click this to 
end your current connection. To connect to any other network shown, select it, and then select 
"Connect". 
The Status Bar 
Information regarding your current network connection can be seen in the status bar along the 
bottom of the VZAccess Manager interface. For more information on this status bar, see the 
section "The Status Bar" in the "Additional Features" section. 
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Note: If you are using a WWAN (1xEV-DO/1xRTT/CDMA) device that supports the Verizon 
Wireless Dial-Up-Data service and you made wireless copies of your dial-up accounts, they will 
also appear. See the section "Creating Wireless Copies of your Dial-Up Connections". 
Optionally you can have all dial-up connections appear in VZAccess Manager and use it to 
launch any dial-up networking connection. See the section "Setting Your Preferences". If you 
are in the presence of a private Wi-Fi network (such as one at work or at home) it will also 
appear if you selected the Wi-Fi option during setup. If the number of connections exceeds what 
can be displayed, a vertical scroll bar will appear to the right of the connections. 
Scroll down to see them all. 
The first time you connect with the NationalAccess - BroadbandAccess, NationalAccess, or Quick 
2 Net (14.4 kbps) connections, or a private Wi-Fi connection, a connectivity warning message will 
appear. You have the option to suppress these warning messages when they are displayed. 
VZAccess Manager will display status information at the bottom during the connection process as 
well as while connected. 
When not connected, the status text in the lower left corner will display "Not connected" for the 
currently selected network. The timer will display "00:00:00". Once connected, the status text will 
display "Connected" and the elapsed timer will begin to run. When a connection is active, its 
name will appear as bold text. The status is also reflected in the Task Tray icon. 
Connected 
Idle - Not Connected  
Connecting 
Disconnecting 
 

 
A window will also slide out of the tray showing when you connect and disconnect 
from networks. 
  
The pop up status can be turned off, if desired, by selecting "Options", "Preferences", "Options" 
tab, un-checking "Show popup status windows by tray". Right clicking on the tray icon provides 
various options and double clicking on it will always show the application. Placing your cursor on 
it will display the current connection status. Based on your preferences, your browser or e-mail or 
VPN program can be launched automatically, or you can launch whatever software you want to 
use. You can also determine if all connections show in the drop down list or only your 
wireless ones, see Setting Your Preferences. 
Note: Always use VZAccess Manager when connecting via the NationalAccess - BroadbandAccess, 
NationalAccess, or Quick 2 Net (14.4 kbps) connection. This will ensure that the Venturi 
compression software is enabled and the wireless device is configured properly before 
connecting. 
At any time during your connection you can check your current connection speed and throughput 
stats in the Statistics tab of the Session Information window. To see this window, select 
"Statistics" from the "Options" menu. 
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The Session Information window will also contain a My Computer tab and a Wi-Fi tab if 
applicable. The My Computer tab contains detailed information about your computer. This 
information is helpful when troubleshooting a problem. 
Additional information when using the Quick 2 Net (14.4 kbps) connection: 
When using the Quick 2 Net (14.4 kbps) connection, VZAccess Manager enables the Venturi 
compression software to roughly double your performance. For additional details see the Venturi 
Instructions. 
Additional information when using the NationalAccess connection: 
By default VZAccess Manager enables the Venturi compression software for the BroadbandAccess 
and NationalAccess connections. If you are using the NationalAccess - BroadbandAccess or 
NationalAccess connection and the call fails when you try to connect, with VZAccess Manager 
returning to its idle state, you should try to connect again. If you are still having trouble, 
 try the Quick 2 Net (14.4 kbps) connection, if your device supports it. If you feel you may have 
incorrectly entered your wireless telephone number during initial setup, select "Options", "Run 
Wizard". 
Dormancy: 
NationalAccess and BroadbandAccess data sessions become dormant if you are not sending or 
receiving any data. As soon as you resume sending or receiving data, the data session will return 
to an active state. Depending on your device and your NationalAccess or BroadbandAccess plan, 
your data session may disconnect during a dormant state. See your Verizon Calling Plan brochure 
for details or visit www.verizonwireless.com. If this happens, select disconnect, and then connect 
again. While dormant your wireless phone / device may be able to receive a voice call. If you 
leave your wireless phone connected to your PC, after you finish your voice call you may be able 
to resume your data session as you normally would. 
3.4 WARNING MESSAGES 
NationalAccess 
The first time you connect via the NationalAccess connection, the following warning message will 
be displayed: 
ATTENTION 
You are about to establish a NationalAccess (1xRTT) connection. Charges apply in accordance with your 
subscription to Verizon Wireless' NationalAccess. To see our current pricing for NationalAccess, please 
visit http://www.verizonwireless.com/b2c/mobileoptions 
This message will display each time you go to connect via the NationalAccess connection until 
you select "Do not show this warning again". 

 



 15

NationalAccess - BroadbandAccess 
The first time you connect via the NationalAccess - BroadbandAccess connection, the following 
warning message will be displayed: 
ATTENTION 
You are about to establish a BroadbandAccess or NationalAccess connection. 
Charges apply in accordance with your subscription to Verizon Wireless' 
NationalAccess/BroadbandAccess.  
To see our current pricing for BroadbandAccess, please visit 
http://www.verizonwireless.com/b2c/mobileoptions 
This message will display each time you go to connect via the NationalAccess - BroadbandAccess 
connection, until you select "Do not show this warning again". 
Quick 2 Net (14.4 kbps) 
The first time you connect via the Quick 2 Net (14.4 kbps) connection, the following warning 
message will be displayed: 
ATTENTION 
Quick 2 Net(sm) may be charged differently than NationalAccess sessions. 
Please check your Calling Plan for details. 
  
This message will display each time you go to connect via the Quick 2 Net (14.4 kbps) 
connection, until you select "Do not show this warning again". 
Dial-Up 
The first time you connect via a wireless Dial-Up connection, the following warning message will 
be displayed: 
ATTENTION 
Dial Up connections may be charged differently than NationalAccess sessions. 
Please check your Calling Plan for details. 
This message will display each time you go to connect via a wireless Dial-Up connection, until 
you select "Do not show this warning again". 
Wi-Fi 
The first time you connect to a Wi-Fi network, you will see the following warning 
You are about to establish a connection to a Wi-Fi network. Verizon Wireless does not support problems 
associated with Wi-Fi networks. Verizon Wireless Customer Care will not be able to assist you. Please see 
the Help file for details. In most cases connecting to a private Wi-Fi network is a simple process 
and you can use VZAccess Manager instead of the Wi-Fi client you would normally use. If you 
have any problems doing this try the recommendations in the section on Wi-Fi Troubleshooting. 
3.5 USING DIAL UP CONNECTIONS 
This section is only applicable if you are using a WWAN Device that supports Dial-Up 
connections (a wireless phone and cable or a PC Card). 
You can make wireless copies of existing dial up accounts on your system. This will wirelessly 
enable them and allow you to connect to them wirelessly. 
To launch the copy utility, select "Options", "Dial-up Accounts" then "Copy". 
Click on the connection or connections you want to copy and click on the "OK" button. 
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The new connection will have a suffix of "(Wireless)" and will be set to use your wireless phone 
as the modem. If the utility is unable to automatically recognize your existing area code and 
number, the existing number will be displayed, and you will be prompted to enter the area code 
and number. The utility configures the new wireless connections to always 
dial 11 digits, so that they will work locally and also in other digital data coverage areas. 
If it is determined that the connection might benefit by further optimization, an additional 
connection with a "(Wireless Optimized)" suffix, will also be created. This connection may 
connect faster. If you have trouble with the "(Wireless Optimized)" connection, you can delete it 
from your dial-up networking folder and use the "(Wireless)" connection. 
Note: Some applications, such as AOL and JUNO, have Dial-Up Networking connections that can't 
be used directly from VZAccess Manager or Dial-Up Networking. Copies of these connections will 
not work with your wireless phone, since the original connections do not work by themselves. In 
most cases the original connections or the software can be configured to use your wireless phone 
or CDMA PC Card as a modem. For the easiest way to configure AOL to work with your wireless 
phone, see the section on Configuring AOL. 
To delete connections: 
If you are using Windows 95, 98, or ME you can access Dial-Up Networking from VZAccess 
Manager by selecting "Options", "Dial-up Accounts", "Edit". To delete a connection, click on it to 
select it, and press the delete key. 
Windows 2000 and XP users can access Dial-Up Networking from VZAccess Manager by selecting 
"Options", "Control Panels", "Network and Dial-up Connections", right click on the desired 
connection and select "Delete". 
3.6 TXT MESSAGING 
VZAccess Manager supports TXT Messaging for PC Cards only, some PC Cards do not support 
TXT Messaging. 
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Receiving TXT Messages 
• All of your TXT messages will appear at the list box at the top of the TXT messaging view. By 
default, all sent and received messages will appear. 
• To view only certain messages, click on the 'View' toolbar button and select 'Received 
Messages', 'Sent Messages' 
or 'All Messages'. 
• If you are in the TXT Messaging view and a new message arrives, the message will 
automatically appear in the list and be displayed in bold. 
• To view a long TXT message, select the message in the list view. The details of the message 
will appear below the list. 
• If you are not in the TXT Messaging view and a new message arrives, a TXT icon will appear in 
the status bar showing that new messages are available. There is also a TXT preference option 
that can automatically switch VZAccess to the TXT view when new messages arrive. By default, 
this feature is turned off. 
• To reply to an inbound message, select the message and press the 'Reply' toolbar button. The 
phone number of the sender will be populated in the send area below. Enter your new message 
and press the 'Send' button to send the message. 
  
• To forward an inbound message, select the message and press 'Forward' toolbar button. The 
message will be populated in the send area below prefixed with a "FW:". Press the 'Send' button 
to send the message. 
• To resend a sent message, select the message and press the 'Resend' toolbar button. The 
phone number and message will be populated in the send area below. Press the 'Send' button to 
send the message again. 
Sending TXT Messages 
• To Send a TXT to an individual or multiple Verizon Wireless messaging subscribers, simply enter 
a Verizon Wireless 10-digit mobile number or click on the To button to open your Contact List. 
Separate each address with a comma, (Ex: 4529067334, 6594556321). 
• To Send a TXT to one of the entries in your Contact List, click the 'To' button to open the 
Contacts window. 
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Simply double click on the name of the user and that individual will automatically be added to the 
'Send To' field. Holding down the 'Ctrl' key while you click names from the lists will allow you to 
select multiple names at once. 
• The phone number and the message field are required. 
• The Character counter counts up from 0 to 160 and counts all of the characters typed in the 
message field. 
• Click the 'Send' button. 
TXT Contacts 
The Address Book allows you to store the names and mobile numbers of your personal contacts. 
To create a personal contact: 
• From the Contact List dialog, press the 'Add' button. 
• Enter the full name of the contact into name into the 'Name' field. 
• Enter either the 10-digit mobile number into the 'Mobile 1' field. 
• The 'Mobile 2' field can be used to enter a second mobile phone number. This is used if the 
individual sends you a message from this number. You will see the user's name next to the 
inbound message instead of the phone  number. 
• Click the 'OK' button. The contact name will now display in the list. 
To edit a personal contact: 
• Click a name from the list and press the 'Edit' button. 
• Make the necessary changes and click the 'OK' button. 
• Clicking the 'Cancel' button will not save any changes you have made. 
• Clicking the 'Delete' button will remove that name from your list. 
Some PC Cards do not support storing of Contacts. 
4 VZACCESS MANAGER PREFERENCES 
This section will cover the preferences that are common to both WWAN and Wi-Fi usage. The 
next two sections will cover preferences unique to WWAN and Wi-Fi. 
4.1 GENERAL PREFERENCES 
This section will cover the preferences that are common to both WWAN and Wi-Fi. The next two 
sections will cover preferences unique to WWAN and Wi-Fi. 
Options Tab 
Click on "Tools", then "Preferences. . . ". 
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Only show preferred wireless networks at start up: This only applies to Wi-Fi networks. If 
checked, at startup, only networks in your Preferred list on the Wi-Fi tab are displayed (networks 
you have connected to in the past) otherwise, all detected networks are displayed. 
Display advanced Wi-Fi network information: This only applies to Wi-Fi networks. If checked, 
additional information will be displayed for Wi-Fi networks such as the channel, MAC address and 
type of security. 
Minimize Application into tray: With this option selected, when you minimize VZAccess 
Manager, instead of taking up space in your taskbar, it will just disappear. You can get it back by 
double clicking on the tray icon , alternatively you can right click in the icon and select "Show 
Application". You can minimize the main window of VZAccess Manager by 
selecting the minimize icon ( ) in the upper right corner of the main window. 
Show popup status windows by tray: Enables status notification in a pop up window above the 
task bar that displays for a few seconds whenever connection status changes. 
Run VZAccess Manager at Startup: Selecting this option adds VZAccess Manager to the 
Windows Startup group, unchecking it removes VZAccess Manager from the startup group. 
Automatically close conflicting applications: With this option selected, VZAccess Manager will 
automatically close any application it recognizes that is known to prevent it from working 
correctly. For example, it may close the client software that was supplied with your Wi-Fi card, if 
it's known to conflict with VZAccess Manager controlling your Wi-Fi card. 
For Wi-Fi, Passwords, and VPN options see section on Wi-Fi Specific Settings. 
For WWAN and Venturi options see section on WWAN Specific Settings. 
Updates Tab 
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This feature allows VZAccess Manager to automatically check for software updates. If an update 
is available, you will be notified of it's size and approximate download times if using 
NationalAccess, BroadbandAccess, Quick 2 Net or any Wi-Fi connection. 
You will be given the choice to download or cancel. If you select download, you will be presented 
with a display that shows the progress as the update is downloading with the option to cancel if 
desired. You do not need to download the updates wirelessly; you can use any connection to the 
Internet. Note: If you download the updates wirelessly, 
normal usage charges apply. 
You can allow the software to check automatically for updates, daily, weekly (default), or 
monthly. It only checks when the application is running and when it detects that you are 
connected and able to access to the Internet. If desired, you can select "Manually" and the 
software will only check for updates when you select "Update Now" (pictured above), or 
you when you select, from VZAccess Manager's main screen, "Help", "Check for Updates". 
4.2 WWAN SPECIFIC SETTINGS 
WWAN Preferences 
Click on "Tools", then "Preferences. . . ". 
WWAN Options 
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Show wireless device battery instead of PC battery: If you only selected to detect and install 
Wi-Fi when installing VZAccess Manager, VZAccess Manager will display the PC's battery status in 
it's main window. If you are using a WWAN device and this option is selected, the battery level of 
your WWAN device will be displayed when your device is connected and detected by VZAccess 
Manager, as well as when you connect and disconnect using your WWAN device. Battery 
Status cannot be updated while you are connected. You can refresh the status when you are not 
connected, by selecting "Tools", "Refresh Signal Levels" from VZAccess Manager's main window. 
Some phones fail to accurately report their battery level to VZAccess Manager and some WWAN 
devices such as PC Cards do not use batteries, so you can use this option to display the PC's 
battery instead. 
Set Options . . . : This is used to set various connect options. See below. 
Automatically Connect: If desired, you can select to have VZAccess Manager automatically 
connect to Verizon Wireless 
NationalAccess - BroadbandAccess or NationalAccess at application startup. 
Show non-wireless accounts in list: If you select this option all of your dial up accounts will 
show up in VZAccess 
Manager's list of accounts, allowing you to use VZAccess Manager to launch them instead of Dial-
Up Networking. With this option unchecked, the only connections that are displayed in VZAccess 
Manager's list of accounts, are the Verizon Wireless NationalAccess - BroadbandAccess, 
NationalAccess or Quick 2 Net (14.4 kbps) connection, (depending on your wireless phone/device 
capabilities) and any Wireless connections you have created, manually or with the Copy Accounts 
Wizard. If VZAccess Manager is also configured for Wi-Fi, these connections will also be displayed 
when in coverage of the hot spot. 
Do not prompt for user name and password: If you are only using the Verizon Wireless 
NationalAccess - 
BroadbandAccess, NationalAccess or Quick 2 Net (14.4 kbps) connection, this setting has no 
effect. If you created 
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Wireless connections to dial into other networks or have existing connections you are going to 
launch using VZAccess Manager, checking this option will skip the screen that normally asks for 
your user name and password. For this to work you will have had to connect previously, 
successfully saving your user name and password. 
Security Setup...: This is used to lock/unlock the PC Card as well as change the lock code on the 
PC Card. 
Connect Tab 
  
When you select the "Set Options" button from the screen above, the following options 
will appear ("Tools", 
"Preferences", "WWAN tab", "Set Options. . . "): 

 
Do not open my browser: With this option selected, when you connect to a WWAN network, 
VZAccess Manager will not automatically launch your default web browser. 
Open my browser to my default home page: With this option selected, when you connect to a 
WWAN network (NationalAccess - BroadbandAccess, NationalAccess or Quick 2 Net), VZAccess 
Manager will automatically launch your default web browser and your home page will load. 
Open my browser to this URL: With this option selected, when you connect to a WWAN 
network (NationalAccess - BroadbandAccess, NationalAccess or Quick 2 Net), VZAccess Manager 
will automatically launch your default web browser 
but do it in such a way that the URL you specify will load instead of your home page. 
Turn off graphics: If you select this it will turn of graphics in Internet Explorer. 
Turn off audio: If you select this it will turn off audio in Internet Explorer. 
With these options off, web pages will load faster but you will have to right click and select "show 
picture" for any pictures you want to see. With the added performance of the Venturi 
compression software when using the Verizon Wireless NationalAccess - BroadbandAccess, 
NationalAccess or Quick 2 Net (14.4 kbps) connection, most users prefer to 
see graphics and have audio support, so the default setting for both options is unchecked. 
Run program on connection: This allows automatically running a program when you use 
VZAccess Manager to connect to a WWAN network. Select the browse button, , to browse to the 
desired application you want to run when you connect to a WWAN network using VZAccess 
Manager. The application will run for all WWAN connections made from VZAccess Manager. 
VPN Tab 
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The following options exist on the VPN tab ("Tools", "Preferences", "WWAN" tab, "Set 
Options. . . ", "VPN" tab): 

  
VPN Client: VZAccess Manager automatically detects if certain VPN clients like Microsoft, Cisco, 
CheckPoint, etc are installed on the compuuter and allows you to select the one you wish to use. 
Check with your network administrator to setup your VPN connection. 
If the VPN client you wish to use does not appear in the list, you can select Other VPN 
Application 
Other VPN Application: This allows automatically running any VPN program when you use 
VZAccess Manager to connect to a WWAN network. Select the browse button, , to browse to the 
desied. 
Security Setup 
When you select the "Security Setup" button from the screen above, the following options 
will appear 
("Tools", "Preferences", "WWAN tab", "Security Setup. . . "): 

 
Lock code: Enter your 4 digit lock code (default is the last 4 numbers of PC Card’s phone 
number) and select Ok to lock or unlock the PC Card. 
Change Lock Code: This is used to change the 4 digit lock code on the PC Card 
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Current lock code: Enter your current 4 digit lock code. 
New lock code: Enter your new 4 digit lock code. 
Confirm new lock code: Re-type the new 4 digit lock code. 
Venturi Tab 
The last WWAN specific option is the "Venturi" tab ("Tools", "Preferences", "Venturi" tab): 
 

The Venturi compression software works in 
the background between your computer and Venturi compression servers on the Verizon Wireless 
network to improve your performance when using the NationalAccess - BroadbandAccess, 
NationalAccess or Quick 2 Net (14.4 kbps) connection. This option is selected by default and 
allows VZAccess Manager to automatically turn the Venturi compression software on when you 
use VZAccess Manager to connect via BroadbandAccess, NationalAccess or Quick 2 Net, and off 
when you disconnect. 
  
Unselecting "Compress and accelerate WWAN connections" will cause VZAccess Manager to no 
longer toggle the Venturi compression software on and off when using BroadbandAccess, 
NationalAccess or Quick 2 Net. The recommendation is to leave this option selected because it 
helps in most cases. There are some rare situations where you may get better performance by 
turning the compression software off, so the option is available. You can also control the 
compression client through its user interface. For additional details see the section on Venturi 
Instructions. 
4.3 WI-FI SPECIFIC SETTINGS 
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The following options are available if you selected "detect Wi-Fi" device during setup. If you have 
added a Wi-Fi device after having installed VZAccess Manager, you can select "Options", "Run 
Wizard" to run the setup wizard again. 
If you connect your Wi-Fi device after VZAccess Manager has been started and you are in 
coverage of a Wi-Fi network, selecting "Options", "Refresh  Networks" will cause VZAccess 
Manager to recognize your Wi-Fi device (and WWAN if connected) and scan for available 
networks. 
Wi-Fi Preferences 
The options relevant to Wi-Fi are found on the "Options" tab and the "Wi-Fi" tab under 
preferences. Select "Options" then "Preferences". 
The first relevant tab is the Wi-Fi tab. 

 
Wireless adapters: In the rare case you have more than one Wi-Fi adapter, you can select the 
Wi-Fi adapter you are using. If your adapter does not appear, try upgrading to the latest 
available drivers from the Wi-Fi device manufacturer. 
Automatically connect to preferred networks: If desired, you can select to have VZAccess 
Manager automatically connect to your preferred Wi-Fi networks when they are detected. 
  
Automatically switch from WWAN to Wi-Fi: Requires that "Automatically connect to preferred 
networks is selected. When you select this option to automatically switch from WWAN to Wi-Fi 
VZAccess Manager will disconnect your WWAN connection (NationalAccess - BroadbandAccess, 
NationalAccess, or Quick 2 Net (14.4 kbps)) and automatically connect via Wi-Fi when a preferred 
Wi-Fi network is detected. WWAN connections are only relevant if using a 1XRTT/CDMA wireless 
phone and cable or an 1XEVDO/1XRTT/CDMA PC Card. 
Preferred Networks: When you connect to or add Wi-Fi networks they will appear in this list. If 
using the "Automatically connect" feature VZAccess Manager will try to connect to the networks 
in the order they appear in this list. 
Move Up: Changes the priority of the Wi-Fi networks you have added or connected to in the 
past. This option is only available when you have two or more Wi-Fi networks in the Preferred 
list. 
Move Down: Changes the priority of non Verizon Wireless Wi-Fi networks you have added or 
connected to in the past. This option is only available when you have two or more Wi-Fi networks 
in the Preferred list. 
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Add: Used to manually add Wi-Fi network. If you select "Add" you will have to enter the 
network's name and indicate if it is password protected. The only time you would need to use the 
"Add" feature would be if the Access Point providing the Wi-Fi coverage does not broadcast it's 
network name (SSID). The easiest way to add a network that broadcasts it's network name, is to 
select the Wi-Fi network connection when it appears, and then select "Connect". If it is password 
protected you will be prompted to enter your WEP (Wired Equivalent Privacy) key. 
Note: If you manually add a Wi-Fi network, when VZAccess Manager finds it, it's signal strength 
will be displayed to the right of the network name when you are within coverage of that network. 
If you incorrectly entered the name, the signal strength will never indicate any signal. 
Note that with certain Wi-Fi adapters the signal strength for Wi-Fi networks is not accurate until 
you connect to the network. 
Edit: If you select a connection in the Preferred Network list, the Edit button will become active. 
Pressing it will provide you with three additional tabs that will be discussed below. 
Remove: This will remove any other Wi-Fi networks you have added or connected to in the past. 
Just select the network, then select "Remove". 
Network Tab 
From the Wi-Fi tab (above, "Tools", "Preferences", "Wi-Fi" tab) if you select a network listed 
under "Preferred Networks" 
then select the "Edit" button or if you select the "Add" button, one of the following options will be 
displayed: 

  
The following options exist on the Network tab: 
Network Name: On the Network tab, for private networks you can edit or enter the Network 
name and specify if it is a closed network. Note: The name has to match the network to work. If 
the network broadcasts it's SSID, instead of manually adding it, select the Wi-Fi network 
connection when it appears, and then select "Connect". If it is password 
protected you will be prompted to enter your WEP (Wired Equivalent Privacy) key. 
Note: The name has to match the network to work. Note that this name is case sensitive when 
entering it.  
Set Password: This option allows you to modify, delete or enter your Wi-Fi WEP keys for a 
private Wi-Fi network.. 
Connect Tab 
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The following options exist on the Connect tab ("Tools", "Preferences", "Wi-Fi" tab, select "Add" 
or a network in the "Preferred Network" list and "Edit", then "Connect"): 

  
Do not open my browser: With this option selected, when you connect to a Wi-Fi network, 
VZAccess Manager will not automatically launch your web browser. 
Open my browser to my default home page: With this option selected, when you connect to a 
Wi-Fi network VZAccess Manager will automatically launch your web browser and your default 
home page will load. 
Open my browser to this URL: With this option selected, when you connect to a Wi-Fi network, 
VZAccess Manager will automatically launch your web browser but do it in such a way that the 
URL you specify will load instead of your home page. 
Disable IE Proxy settings for this connection: This option provides an automatic method to 
turn off proxy settings when connecting to a Wi-Fi network. This would typically be used if you 
normally use proxy settings at work to access the Internet and you wanted to access the Internet 
directly via Wi-Fi without using VPN (Virtual Private Networking) software. 
Run program on connection: This allows automatically running a program when you use 
VZAccess Manager to connect to a Wi-Fi network. Select the browse button to browse to the 
desired application you want to run when you connect to a Wi-Fi network using VZAccess 
Manager. The application will run for all Wi-Fi connections made from VZAccess Manager. 
VPN Tab 
The following options exist on the VPN tab ("Tools", "Preferences", "Wi-Fi" tab, select "Add" or a 
network in the "Preferred Network" list and "Edit", then "VPN"): 
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VPN Client: VZAccess Manager automatically detects if certain VPN clients like Microsoft, Cisco, 
CheckPoint, etc are installed on the compuuter and allows you to select the one you wish to use. 
Check with your network administrator to setup your VPN connection. 
If the VPN client you wish to use does not appear in the list, you can select Other VPN 
Application 
Other VPN Application: This allows automatically running any VPN program when you use 
VZAccess Manager to connect to the Wi-Fi network you added or edited. Select the browse 
button to browse to the desired VPN application you want to run when you connect to the Wi-Fi 
network you added or edited, using VZAccess Manager. If you have a shortcut you normally use 
to launch your VPN application you may want to right click on it and select properties to see 
where the program is located and how it's named. 
Option Tab 
The last tab in Preferences that has Wi-Fi specific settings is the Options tab ("Options", 
"Preferences", "Options"): 
Only show preferred wireless networks at start up: This only applies to Wi-Fi networks. If 
checked, at startup, only networks in your Preferred list on the Wi-Fi tab are displayed (networks 
you have connected to in the past) otherwise, all detected networks are displayed. You also have 
the option in the main screen of VZAccess Manager of selecting "Show All 
Networks" when only preferred networks are displayed and you have the option to select "Show 
Preferred" networks when VZAccess Manager is set to show all detected networks. 
Display advanced Wi-Fi network information: This only applies to Wi-Fi networks. If checked, 
additional information will be displayed for Wi-Fi networks such as the channel, MAC address and 
type of security. 
The rest of the features on this tab are explained in the section on Setting Your Preferences. 
4.4 TXT MESSAGING SETTINGS 
The following options are available for PC Cards only that support TXT Messaging. 
  

TXT Messaging Preferences 
Click on "Tools", then "Preferences. . . ". 
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Incoming message options 
• Open TXT window on arrival of new message: VZAccess Manager will automatically switch to 
the TXT view when a new message arrives 
• Play sound on arrival of new messages: A sound file (.WAV) can be selected to play when 
new messages arrive. 
Outgoing message options 
• Message delivery duration: The duration of time that the Verizon Wireless network will 
attempt to deliver the message. The default is a duration of 1 week. 
Confirmations: The following confirmation dialogs can be turned on or off: 
• Warn before deletion of messages 
• Confirm deletion of messages 
• Confirm sent messages 

5 ADDITIONAL FEATURES 
In addition to the basic features mentioned in previous sections, VZAccess Manager has the 
additional features listed below. 
  

5.1 THE STATUS BAR 
The details of your current connection can be seen in the status bar at the bottom of the 
VZAccess Manager interface.  
This status bar is always visible when the interface is fully expanded. For information on 
minimizing the VZAccess Manager interface, see the section "Minimizing the Interface". 

 
Connection Status 
The text on the top left portion of the status bar above the "Verizon Wireless" text reflects your 
current state. During an active connection, this text will change to "Connected". If you are not 
connected, it will display "Not Connected". 
WWAN PC Card Status Area 
The text that reads "Verizon Wireless" can change to the following: 
• Device not inserted - Your WWAN PC Card is removed from the laptop. 
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• Device not activated - Your PC Card needs to be activated. Select Activate from the Options 
menu. 
Coverage 
For PC Cards, an icon will display if you are in NationalAccess or BroadbandAccess coverage. 
Hover the mouse to see the tool tip showing the name of the current network. 
New TXT 
If your device supports TXT messaging, an icon appears on the status bar to show that you have 
a new TXT message waiting. Double click on the icon to jump to the TXT view to see the 
message. 
Throughput 
The amount of data that you have sent and received since the current network connection was 
initiated can be seen by holding the mouse over the green up and down arrows on the right side 
of the status bar. 
Battery Level 
The current battery level of your mobile phone can be seen on the right side of the status bar. 
Elapsed Time 
The amount of time that has elapsed since the current network connection was initiated is 
tracked on the lower right side of the status bar. 
Roaming Status 
VZAccess Manager displays Roaming status for PC Cards. These icons will show on status bar in 
these scenarios: 
Icon Status 
Roaming 
Extended Network 
No icon displayed Home Network 
5.2 THE TOOLBAR BUTTONS 
  

 
The "Connect" button 
Displays all of your available wireless connections and networks. Please refer to the Connecting 
section earlier. 
The "Usage" button 
Provides a concise session log of your network activity. Click on a column heading to sort the log. 
This window also 
displays the total number of sessions as well as the total time connected. 
The information displayed in the Usage log can be customized using the controls that appear just 
below the list. 

 
To view only the connection history of a specific network type, check the "Selected connection" 
checkbox and select the desired type from the drop-down list. To view only the connections 
made during a specific interval, check the "Date range" checkbox and specify the date in the 
"From:" and "To:" fields. 
To export this log as a CSV file, click the Export button that is immediately above the log. To 
clear the log, press the Clear button. Note that clearing the log cannot be undone. 
The "Apps" button 
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Add applications here that you want easy access to while connected to the wireless Internet. 
VZAccess Manager will preload into this view links to Verizon Wireless web sites, and any 
Microsoft Office applications you have loaded on your computer. 
The "TXT" button 
The TXT button allows you to send short text messages to any other wireless device that 
supports SMS. Note that this button is only available when using a wireless device that supports 
TXT Messaging . 
The "Web" button 
Launches the default web browser on your computer. 
The "Email" button 
Launches the your default email application on your computer. 
The "Support" button 
Displays a variety of help options available to you. Click this button to find assistance with a 
problem, to explore the full range of VZW products and services, or to contact Verizon Wireless. 
  

5.3 MINIMIZING THE INTERFACE 
The VZAccess Manager interface can be minimized to take up as little screen real estate as 
possible. To minimize the interface, select "Minimum" from the "View" menu. 

 
To return the VZAccess Manager interface to the normal size, select "Minimum" from the "View" 
menu again. 
5.4 THE TOOLS MENU 
Control Panels: From this menu you have access to your systems "Modem", "Network and Dial-
Up Connections", and "Internet" control panels. You can also see all control panels by selecting 
"All". 
Dial-Up Accounts: Add, edit, or copy wireless dial-up accounts. 
• Add Wireless: This is used to create a wireless dial-up connection from scratch. 
• Add Other: This is used to create a regular dial-up connection from scratch. 
• Edit: This is used to edit properties of any dial-up connection. 
• Copy: See section on Using Dial-Up Connections. 
Note: These options are only applicable if using a WWAN device (Wireless Phone and cable or 
1xRTT/CDMA PC 
Card) that supports dial-up accounts. 
5.5 THE OPTIONS MENU 
Refresh Networks: This causes VZAccess Manager to verify devices connected and to scan for 
available Networks. Use this feature if you connected your equipment after launching VZAccess 
Manager. Pressing the F6 function key can also access this option. 
Refresh Signal Levels: This causes VZAccess Manager to query signal levels and update it's 
display. This will also update the battery display for your WWAN device  if it is not in an active 
data session. Signal levels are automatically refreshed when you launch VZAccess Manager, 
connect or disconnect. Pressing the F5 function key can also access this option. 
Statistics: If you selected to detect and install Wi-Fi during installation, there will be a Wi-Fi 
statistics tab with additional information and tools that are helpful in the event any 
troubleshooting of the connection is required. You can view key statistics including bandwidth 
and your IP address information, release your IP address, renew your IP address. If you 
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selected to detect and install a WWAN device during installation, there will be a Statistics tab that 
will show data speeds during a session when using the WWAN device. Quick 2 Net is capable of 
data speeds bursting up to 14.4 Kbps. 
NationalAccess delivers typical speeds of 60 to 80 kbps, bursting up to 144 kbps. 
BroadbandAccess provides broadbandlike speeds (up to 1.54 Mbps). There is also a "My 
Computer" tab; this tab has key information about your computer that   
may be helpful in troubleshooting any problems that may occur. It also has the option of being e-
mailed to Verizon Wireless Technical Support. 
Test WWAN Device: Retrieve and display detailed information about your WWAN device 
(Wireless phone and cable or 1xEV-DO/1xRTT/CDMA PC Card) such as manufacturer, model, 
version, etc. Also, see the current battery (not with PC cards) and signal strengths. This 
information can be valuable when troubleshooting a problem. 

 
Run Wizard: Runs the Setup Wizard again. Useful if you need to reconfigure VZAccess Manager 
to use a new mobile handset or PC Card. 
5.6 THE HELP MENU 
Contents: Launches this help file. You can also access this help file from your installation CD. 
Check for Updates: Can be used with any connection to the Internet to check for software 
updates for VZAccess Manager. Note: If downloading an update wirelessly, normal usage charges 
apply, - see Update Options in Setting Your Preferences. 
Device Support Page: Takes you to the Verizon Wireless device support page that contains 
information about wireless devices, useful tips and hardware manuals. 
E-mail Verizon Wireless Support: This option will attempt to launch your mail client with the 
default address to e-mail Verizon Wireless Support. 
About VZAccess Manager: Displays the software version. 

6 VENTURI COMPRESSION SOFTWARE 
Venturi, on average, roughly doubles your web browsing performance when connecting to the 
Internet when using a WWAN device (Wireless phone and cable or 1xEV-DO/1XRTT/CDMA PC 
Card) and the NationalAccess - BroadbandAccess, 
NationalAccess or Quick 2 Net (14.4 kbps) connection. Performance can vary due to many 
factors. 
Here's how it works: 
  
The Venturi client intercepts your request from your web browser and passes it to a Venturi 
compression server on the Verizon Wireless Network. The server gets your web content, reduces 
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the quality of the graphics, to reduce their size, and compresses the text that makes up the rest 
of the web page. The now compressed page, smaller in size, is sent to the 
client. The client decompresses the page and passes it to your browser. Performance is improved 
since less information has to be sent for you to get your web page. 
6.1 SUPPORTED PROTOCOLS 
The following protocols are supported: 
• HTTP (used for web pages) 
• HTTPS (used for secure web pages) 
Note: Due to encryption secure web pages are not compressed, but Venturi still improves HTTPS 
performance. 
• FTP (used when accessing Internet file servers) 
• POP3 (used to access some e-mail servers) 
• IMAP (used to access some e-mail servers) 
• SMTP (used for e-mail, send mail servers) 
• Telnet and Secure Shell (used for terminal applications accessing other computers) 
Note: Although Venturi supports these protocols, you may not be able to access certain servers if 
they are not accessible via any connection to the Internet. For example, many Internet Service 
Providers only allow access to their send mail servers when you are connected to the Internet 
through them. They do this to minimize fraudulent use of their send mail servers. An alternative 
is to use the Verizon Wireless Send Mail Server or to use web based e-mail, such as Microsoft's 
Hotmail (http://www.hotmail.com). For more details, see section on Using E-mail with Mobile 
Office. 
6.2 USING VENTURI 
Task Tray Icon 
The Venturi compression software loads automatically at startup. 
You will see an icon of a "V" in your system tray. 
This icon indicates the following states: 
If you see a Purple "V", Venturi is idle and on. 
When Venturi is processing requests the "V" will spin. 
If the V has a Red X through it, either the Venturi compression software is off or in 
bypass mode. If the client is on and enters bypass mode, this is an indication that the client was 
unsuccessful communicating with the Venturi server. In the rare case of this happening, Venturi 
will automatically resume working as soon as it's able to reach the server. While in bypass mode 
you will still be able to access web pages, but Venturi compression will not occur. The spinning V, 
as you browse web pages, is an indication that Venturi is working. 
Task Tray Options 
If you right click on the Venturi task tray icon ("V") a menu will appear. 
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"About Venturi" will display the version of the client. 
Speed/Image Selection - You have the option of selecting the quality of graphics you want 
Venturi to provide by clicking on one of the four car images. It's a tradeoff between speed and 
image quality. With any of these settings, you can always force a web page to load with 
uncompressed images by doing a forced refresh. If using Internet Explorer this is 
accomplished by holding down the "Ctrl" key + "Alt" key + the "Shift" key and then 
clicking on the refresh icon. If using Netscape, hold down the shift key and click on the 
"Reload" icon. "OFF" and "AUTO" clicking on these allows you to switch the client between 
"AUTO" and "OFF" (or "ON" and "OFF", if configured for manual mode). 
If you are using VPN (Virtual Private Networking) or are connected wirelessly to a private 
network or Internet Service Provider where the Verizon Wireless Venturi servers are not 
reachable, you may want to turn Venturi off so you don't have to wait for it to determine that no 
server is available and switch into its bypass mode. Also, in the rare case you 
have an issue accessing a particular site, you can also temporarily turn Venturi off. Remember to 
turn it back on when you want to use it. 
The BroadbandAccess / NationalAccess / Quick 2 Net version of Venturi is configured by default 
to use Auto mode. This means that it loads, turns off ("V" in tray with a "X" through it), and 
expects an external program to turn it on ("V" without the "X") when you connect wirelessly and 
turn it off when you disconnect. The VZAccess Manager software performs these functions. 
"Default Venturi Server" displays the address for the Venturi compression servers on the 
Verizon Wireless Network, this is set to expressnet.myvzw.com. By default this value can not be 
changed but may be used for troubleshooting when working with Verizon Wireless support. 
"Exit" will close Venturi; You can start it again from your "Start Menu", "Programs", "Venturi 2". 
To start using Venturi: 
Make sure that Venturi is set to "AUTO" (or "On" if configured for manual mode), connect to the 
Internet by selecting "NationalAccess - BroadbandAccess", "NationalAccess" or "Quick 2 Net 
(14.4kbps)" from VZAccess Manager and then "Connect". Once connected, start browsing web 
pages. 
Additional Tips: 
  
If you ever have trouble loading a page or signing into a site you can temporarily turn 
Venturi off by doing 
the following: 
1. Click on Stop in your browser to stop any data being processed by Venturi. The "V" should 
stop spinning. If it does not, exit your browser. 
2. Right click on the Venturi icon in the tray to bring up the user interface. 
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3. Click on "OFF". 
4. Click on Refresh or Reload in your browser, to reload the page. If you had to exit your browser 
in step 1, launch it and navigate to your desired page. (It should also appear in your browser's 
history.) 
5. To turn Venturi back on, simply right click on the Venturi icon in the tray and click on "AUTO" 
(or "ON" if configured for manual mode). 
Note: If your browser fails to stop passing data to Venturi and the "V" will not stop spinning to 
allow you to toggle Venturi off, exit your browser, toggle Venturi off, and then launch your 
browser again. 
If you ever have a web page where a graphic fails to load, try right clicking where the 
graphic should have 
loaded and select "Show Picture" or "View Image", and just that image will be requested 
and load. 
6.3 DOWNLOADING VENTURI 
The VZAccess Manager should come with the latest version of Venturi, but you can check the 
following web site for updates to this software: www.venturiwireless.com/support.html 
For troubleshooting tips on using Ventrui, see the On-Line help. 
 


